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You already know the productivity power of 

Office applications like Word, PowerPoint, 

and Excel. This crash course will show you 

how adopting cloud-based Office 365 

gives you ever-improving versions of those 

apps, with new capabilities delivered every 

month. You’ll also learn how Office 365 

empowers you to access your content from 

any device, coauthor with anyone in real 

time (regardless of whether or not they’ve 

purchased a copy of Office), and use the 

power of artificial intelligence (AI) to create 

more impactful content with less effort.

Office 365 gives you the Office apps 

you already know, along with powerful, 

simple new ways to work better together. 

That means services like business-class 

email, online storage, and teamwork 

solutions that you can now access from 

almost anywhere—all designed for small 

businesses like yours. With Microsoft Teams 

included, you can host productive online 

meetings with coworkers, customers, and 

suppliers no matter where they’re located. 

00. Introduction

Getting more capabilities in one solution 

reduces the amount of time you spend 

managing technology and gives you the 

most value for your investment. Office 365 

also provides peace of mind that Microsoft 

is working 24/7 to help protect you against 

security threats—including automatic updates 

to ensure your employees will always have the 

latest features.

If you have more advanced needs, consider 

Microsoft 365, which provides advanced 

security and device management capabilities 

to help safeguard your business. It’s a 

complete, intelligent solution that empowers 

your employees to be creative and work 

together, securely. 

Whatever you choose, you’ll get the 

right solutions for today, with room 

to grow tomorrow. Ready to get 

started? Let’s dive in.
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01.

Get more 
done
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Running a business 
means being ready to 
work wherever you go—
and giving employees 
that same ability.
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Office 365 helps your team perform at its 

best, whether in the office, working from 

home, at a client site, or on the road. You 

get Word, Excel, and PowerPoint for iOS 

and Android in addition to the PC versions 

can install on up to five devices.  

But it’s also much more than that. With 

OneDrive for Business, team members 

can securely access, save, and share files 

in the cloud using their favorite devices—

including Word, Mac, iOS, and Android. 

Plus, the services included in Office 365 

all work together, so you can focus on 

getting work done rather than managing 

apps and passwords. 

Will Hawkins 
President, 

Allpro Construction

The number-one benefit of 

Microsoft 365 for us has been 

the improved access. We have 

access to everything, anywhere 

we are in the world, as long as 

we can get online.
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Word

Need to give feedback to a colleague while 

commuting? Edit documents on your Android 

or iPhone with the Word mobile app. To add 

comments, tap anywhere in a document, then 

click Edit and type your comment. If this is your 

first time adding a comment, you’ll be asked to 

enter a username so other people know who 

edited the document. 

Excel

Mobile-friendly Excel shortcuts make it easy to 

gain insights from information. Add formulas 

using your tablet’s on-screen keyboard, or by 

tapping the Formulas tab. The Recommended 

Charts feature helps you pick visualizations 

that make sense for your screen.

Take your work with you

With Office 365, the familiar Office apps you use every day 

become productivity powerhouses, giving you the ability to 

edit, share, and work together wherever your employees go. 

PowerPoint

Prep and present on the go, right from your 

tablet or smartphone. Presenter view gives 

you full control over what your audience 

sees, showing speaker notes only on your 

mobile device. New ink, laser pointer, and 

highlighting features help emphasize key 

concepts as you present.

OneNote

With OneNote 2019, you can invite others to 

a shared notebook by choosing File > Share 

> Invite People. To share a notebook during 

a meeting, choose File > Share > Share with 

Meeting. After others in your team open the 

notebook, anyone with permissions can add 

meeting notes simultaneously, which then 

sync automatically. 
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Keep your files handy

OneDrive for Business enables effortless 

access to files, including 1 TB of data for 

each user—so your employees can work 

together and share documents easily, 

wherever they are. Preview more than 270 

common file types right from OneDrive 

for Business—no need to open a separate 

app. You can even stream video on demand 

without waiting for it to download. Access 

and edit documents offline, and when 

you’re back online your updated files sync 

automatically. Pick up where you left off 

in your document when switching devices. 

View or revert to a previous version of your 

document thanks to automatic saving and 

file versioning.

Get more organized

Stay productive with a clear, unified view of 

your email, calendar, contacts, and tasks in 

one place with Outlook—on PCs, Macs, iOS, 

and Android, as well as through your web 

browser. You can also get business-class 

email without the hassle of managing your 

own server thanks to full-featured Exchange 

in the cloud.

Give employees one place to 

work together

Microsoft Teams, part of Office 365, is a digital 

hub where employees who work closely 

together on core projects—including people 

outside your organization—can actively 

connect and collaborate in real time to get 

things done. Have a conversation right where 

the work is happening, whether coauthoring 

a document, having a meeting, or working 

together in other apps and services. Teams 

is the place to have informal chats, iterate 

quickly on a project, work with team files, and 

collaborate on shared deliverables.

It brings together conferencing, online storage, 

group workspace, and Office apps all in one 

place, increasing your productivity and helping 

you grow with confidence.
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02.

Work better 
together
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Making decisions, 
generating fresh ideas,  
and building close 
relationships with suppliers 
and customers demands 
good collaboration. 
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With more employees working from home, 

on the road, or from other locations, 

collaboration isn’t always easy. Using 

Microsoft Teams in Office 365, you can 

easily host online meetings to get work 

done in real time, bringing together 

employees, customers, and suppliers all in 

one place.

With Office 365, you can easily set up 

online meetings with either voice only, 

or voice and video. People can also work 

on documents together in real time, even 

if they are in different locations, and 

immediately see changes.

Jarom Reid 
Chief Executive Officer, 

Carpool Agency

Let your people work from 

wherever, because with 

Office 365 you have a digital 

environment that allows you 

to track what your people 

are working on. There are 

huge savings opportunities in 

shifting to a digital office.

Introduction 01 02 03 04 05 06 Closing
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Coauthor with confidence

Real-time coauthoring allows your employees 

to edit the same version of a document at the 

same time. This eliminates the need to email 

multiple versions back and forth.

To get started using real-time coauthoring, 

save your document to OneDrive for Business. 

Then click the Share button, located in the 

upper-right corner of the window. You can 

share and work together on files with people 

inside and outside your organization—even 

with those who don’t have Office 365.

• In the History pane, see at a glance when a 

file was created and modified.

• Revisions are listed by date and name, so 

you can follow up with questions if needed. 

• Click on a version to open it and see how it 

differs from later versions of the same file. 

• If you want to revert to an older version of 

a file, just hit Restore.

Introduction 01 02 03 04 05 06 Closing

Share simply

Stop the confusion created when employees 

send documents by email. With Outlook 

2019, you can upload files to OneDrive, or 

easily attach them to an email, enabling 

everyone with authorization to access, view, 

and edit the same version. When attaching a 

file to an email, you’ll see a list of your recent 

documents — so you can spend less time 

searching for the right one to attach.
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               Meet on the go

Host and join meetings from the Teams app. 

You can chat, manage meeting controls, 

zoom in when someone is sharing their 

desktop, and even reschedule meetings all 

from your mobile device.

Bring people together

With one click, anyone you authorize inside 

or outside your company can join your 

online meeting, from any device. Choose to 

meet right away, or schedule from Outlook 

for later.  

Be creative and productive

When you meet through Teams, it’s not all 

talk. You can present with interactive tools 

such as on-screen annotation, highlighting, 

and virtual laser pointer. Draft, draw, and 

edit together, and see each other face to face 

with HD videoconferencing—it’s almost like 

being in the same room.

Master your meetings

Effective communication strategy is at the 

heart of any successful team. From initiating 

a one-on-one dialog to driving a team 

meeting, Office 365 gives your employees 

control over their conversations, so they feel 

connected wherever they are.

Teams puts you in the driver’s seat

• Before a meeting: Share files in Teams so 

it’s easy to access relevant documents and 

other materials. 

• During a meeting: Participants can chat, 

share their screens, and share files. The 

meeting experience makes it easy to 

Whiteboard, instant message, coauthor, 

and move seamlessly from voice to video. 

Record the meeting with one click to 

share later.

• After a meeting: Put follow-up actions 

in the conversation thread of your Teams 

channel.
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Get a digital home for projects

Whether you’re teaming up on a new product 

strategy, a sales presentation, or a key company 

initiative, SharePoint keeps content at the 

center of teamwork. Files, sites, and content are 

easily shareable and accessible across teams 

and organizations.
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03.

Build your 
business



Crash course in Office 365 16

Success comes 
down to finding 
new customers—
and delivering great 
experiences that 
keep them loyal. 
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Office 365 gives you new ways to track 

and manage prospects, build deeper 

relationships, and create a polished, 

professional image so you can stay 

competitive as customer expectations 

grow. It also helps you streamline 

processes, giving your employees more 

time to focus on value-added tasks and 

provide great service. 

Heyward Garner 
Chief Operating Officer,

Garner Foods

We use Microsoft 365 Business 

to help keep production 

running smoothly and to make 

sure that we are getting the 

right message to the right 

people at the right time.

Your Office 365 apps learn from your personal 

style and help make you more productive with 

built-in intelligence designed to save you time 

and get the results you want.

• Word Editor is an advanced proofing tool 

that checks spelling and grammar and makes 

intelligent style suggestions to help you write 

with greater impact, whether it’s a customer 

proposal or an all-company memo. 

• PowerPoint Designer automatically 

generates design ideas to match the content 

you’re putting on a slide for professional-

looking presentations every time. Ask for 

design ideas by choosing Design > Design 

Ideas on the ribbon.

• Smart Lookup lets you select a word 

or phrase in Excel, Outlook, Word, 

or PowerPoint and right-click to get 

information, definitions, history, and other 

resources right on the page.

• Professionally designed templates speed 

the creation of almost any document, 

whether it’s a business pitch, marketing 

plan, or budget proposal.

Bring your ideas to life 

like a pro
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Engage with your customers 

more effectively

As your business grows, keeping track 

of customer information can be a 

challenge. Office 365 can provide you 

with easy-to-use tools for ensuring you 

never lose sight of opportunities.

Keep customers close

Still keeping customer details in a 

spreadsheet? Nurture relationships 

with Outlook Customer Manager, the 

CRM designed especially for businesses 

with fewer than 10 employees. 

It automatically tracks customer 

interactions and lets you view customer 

details, history, deals in progress, and 

pending tasks right within Outlook. 

           Customer appointments made easy

Simplify the process of scheduling and 

managing customer appointments with 

the convenient, web-based Microsoft 

Bookings app, empowering customers to set 

appointments at their convenience. Share 

your appointment schedule on Facebook, 

manage customer preferences, customize 

staff and service scheduling, and manage it 

all from your browser or mobile app. Select 

Bookings from the Office 365 app launcher.

Get paid on time

Invoicing is an easy-to-use online and mobile 

app that helps you send invoices, manage 

your expenses, and monitor your cash flow. 

With Invoicing, you can get paid faster by 

seamlessly creating, editing, sending invoices, 

and accepting payments. You can even add 

new customers, mark invoices as paid when 

you receive payment, and view monthly and 

yearly sales. Get paid via PayPal and sync 

information with QuickBooks. 
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Coordinate your employees         

and projects

You know how important it is to work 

efficiently. With easy-to-use planning, 

scheduling, and task-tracking tools, you can 

get more done and save time and money.

Plan to win

Take the surprises out of teamwork and get 

more done. Microsoft Planner makes it easy 

for your team to create new project plans, 

organize and assign tasks, share files, chat 

about what you’re working on, and get 

updates on progress. Launch Planner from 

the Office 365 app launcher with a single click 

to create a plan, build a team, organize and 

assign tasks, and update status as you go. It’s 

an easy way to keep your projects on track.

               Beat those deadlines

Tackle your task list using Microsoft To-Do, 

which helps you manage, prioritize, and 

complete the most important things you 

need to achieve every day. Integrated with 

Office 365 apps, To-Do provides intelligent 

recommendations about what’s most 

important. Suggestions look at your to-dos 

across your lists and recommends the most 

important ones to focus on. Add reminders, 

due dates, and notes, and personalize each list 

with colorful themes.

Introduction 01 02 03 04 05 06 Closing



Crash course in Office 365 20

Optimize your processes

Whether it’s filling out forms, tracking 

expenses, or moving data from one app to 

another, every company has mundane tasks 

that take up precious time. Office 365 gives 

you easy ways to automate your everyday 

administrative tasks to free up time for more 

important work.

Work less, do more

Microsoft Flow helps you create automated 

workflows to share information between 

apps, set up approval chains, get notifications, 

and more. Start from a wide range of 

prebuilt templates that make it simple to use 

intelligent automation. For example, use Flow 

to transfer information entered by a sales 

team in Microsoft Dynamics to a SharePoint 

list used by operations. Flow also integrates 

with on-premises and third-party services. 

Create custom apps—no code 

required

Build apps with the power to transform your 

business using PowerApps. Without writing 

code, you can create apps that interact with 

data in SharePoint lists and libraries, as well 

as other cloud and on-premises sources. 

Use PowerApps to create digital experiences 

that take advantage of technology—such 

as cameras on mobile phones—to work in 

innovative ways. 

Make every mile count

If you travel, tracking your mileage can 

be one more daily hassle that slows you 

down. Office 365 offers MileIQ,1 a smart app 

that automatically tracks your miles, helps 

you easily classify drives, and generates 

comprehensive reports for reimbursement 

or tax deduction. 
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04.

Simplify to 
succeed
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With an assortment of 
third-party tools and 
subscriptions, you have 
to manage everything 
separately, your data is 
all over the place, and 
the learning curve for 
employees can be high.
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Office 365 brings the widest range of 

workplace solutions together in one place, 

making them easy to use, easy to manage, 

and powerfully productive. With an online 

dashboard, you have one place to manage 

users, devices, and services. Plus, with 

Office 365 in the cloud, Microsoft takes 

care of the infrastructure—so you can focus 

on growth. You don’t have to purchase or 

maintain on-premises servers to have a 

complete business solution. 

Rick Lord 
President and Chief Executive Officer,

AIM

We migrated early based on 

the recommendation from 

Microsoft. Not only was it a 

smooth transition, but it will 

save us money by simplifying 

management and eliminating 

our need for hardware. We’re 

down to just one server.
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Always up to date

Unlike earlier desktop versions of 

Office, Office 365 updates happen 

automatically, ensuring your employees 

always have the latest features and 

updates. You don’t have to manually 

install upgrades or worry about licensing 

them individually. It’s all included. 

Get employees up and 

running—fast

Setting up new employees with Office 

365 is simple—they just sign in to office.

com with their login and password. They 

can immediately access online versions 

of Office apps, email, and all the tools 

that come with Office 365. One license 

covers fully installed, always-up-to-date 

Office apps on up to five phones, five 

tablets, and five PCs or Macs per user. 

On desktops, productivity starts right 

away thanks to streaming download 

technology. When an employee leaves, 

removing their access to your business 

data is just as easy. 

Get the most from your 

investment 

Because Office 365 is delivered as a cloud 

subscription service, you don’t have to wait 

to get the latest features and apps, and you 

don’t pay more for updated versions. You 

can be assured that you have the most up-

to-date solutions for growing and managing 

your business, on every device, without 

having to manually install anything. Plus, 

with guaranteed 99.9 percent uptime and a 

financially backed service level agreement 

(SLA), your can rest assured your tools will be 

there when you need them.

Sign in once

Keeping track of multiple passwords doesn’t 

just slow things down—it can lead to risky 

practices such as writing down passwords 

on paper or reusing them. Office 365 gives 

employees access to everything they need 

with one password, with end-to-end security 

across all applications and services.
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05.

Safeguard 
your 
business
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Keeping your data safe 
from cyberthreats is a 
top priority—a breach 
could bring significant 
legal, financial, and 
customer satisfaction 
consequences. 
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With Office 365, security is built in at every 

layer to help keep your data safe from 

attackers and accidental leaks, control who 

has access to information, and provide 

peace of mind that you are compliant. 

Ryan Taylor

IT manager, 

iSalon

Data loss prevention sold us 

on Microsoft 365. Having 

our identities hosted in the 

cloud means we won’t have 

to worry about a domain 

controller failing and causing 

data loss or downtime.

Protect against security threats

You don’t need a big IT department to get 

enterprise-grade protection. With best-in-

class services designed for businesses like 

yours, Office 365 helps protect against spam, 

malware, viruses, phishing attempts, malicious 

links, and other risks.

Keep advanced threats at bay

Sophisticated threats can fool even vigilant 

employees. Office 365 Advanced Threat 

Protection guards against hidden malware in 

links and email attachments, and keeps you 

a step ahead of viruses, ransomware, and 

evolving attacks.

Control your data wherever 

it goes

Mobility is a good thing, but only if you can 

keep your data safe. Office 365 Mobile Device 

Management lets you set policies to help 

control access to your organization’s Office 365 

email and documents for supported mobile 

devices and apps. With an advanced solution, 

such as Microsoft 365 Business, if a device 

is lost or stolen, you can remotely wipe it to 

remove sensitive organizational information.
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Prevent data loss

Office 365 also helps you restrict the 

copying or saving of company information 

to unauthorized apps and locations. It 

prevents sensitive information, such as 

social security numbers or credit cards, 

from leaking—saving your business from 

the costs and damage of a data breach.

Manage compliance 

more easily

Microsoft also offers robust contractual 

data privacy and security commitments 

by default to help customers comply 

with local and national regulations. The 

Online Services Terms contract includes 

the EU Model Clauses, UK Data Protection 

Act, HIPAA/HITECH, and many other 

provisions. It applies as soon as customers 

accept the Microsoft License Agreement.

Microsoft doesn’t use your data

Microsoft’s commercial online services, 

including Office 365, do not capture, maintain, 

scan, index, share, or use any data-mining 

technology. This means your email will never 

be scanned for ad-serving purposes, nor 

will the data you store with us be read or 

unknowingly shared with third parties in any 

way. You’ll also benefit from fully customizable 

controls that enable you to tailor enterprise-

grade security services to best meet your 

company needs.

Email security that just works

Email is a major gateway in and out of your 

organization. Prioritize security across the 

board with protection from external threats 

and defend with internal access controls. To 

deal with external threats and unknown risks, 

Office 365 helps secure employee mailboxes 

against sophisticated attacks in real time, 

eliminating the need to install additional virus-

scanning software. Every email attachment or 

link is automatically evaluated for suspicious 

activity, and malicious content is neutralized 

before an attack can occur.
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06.

Complete your 
solution
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By choosing Office 365, 
you’re investing in growth 
and success. Its productivity 
and collaboration tools—
plus built-in security—
provide a solid foundation 
for your modern workplace. 
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How you take the next step can enable even 

greater transformation. When you get Office 

365 as part of Microsoft 365 Business, you get 

the power and familiarity of Office 365 with 

advanced security technologies, as well as 

streamlined management and maintenance, 

built specifically for businesses like yours. 

It’s designed to keep company data secure 

while ensuring employees are their most 

productive, in the office or on the go.

Microsoft 365 includes features such as:

• Information protection policies to help 

control and manage how information is 

accessed.

• Controls to protect your company data 

on personal mobile devices.

• The ability to securely manage iOS, 

Android, Windows, and macOS devices.

Christoffer Tykö 

Internal IT Team Leader,

Play’n GO

Once our employees 

understood the full 

capabilities of Microsoft 365, 

productivity and efficiency 

increased definitively.
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Crash course 
finish line 

See plans and pricing 

for Office 365 Business

Learn more about 

Microsoft 365 Business 

This crash course in Office 365 

demonstrates the breadth of capabilities it 

offers for empowering your business.

Building on the foundation of Office 

solutions you use every day, Office 365 

brings you new capabilities for working 

better together, wherever opportunity 

takes you. From easy online meetings to 

mobile document editing, from simplified 

management to comprehensive protection 

for your sensitive data, it helps you take 

advantage of all the talent and resources 

you have to compete and win. 

Now that you’ve completed the Office 365 

crash course, it’s time to take a closer look  

at exactly which Microsoft plan is right for  

your business. 
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